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This 3d art (opens in new tab) tutorial will focus on the creation of a semi-stylised avatar in iClone’s Character Creator. I will demonstrate the character morphing process using a base model and then show the transformation into my new character design using a combination of both Character Creator morphs and sculpting customisations.We will
mainly work in Character Creator and have a look at the Essential Morphs and Skin packs. Additionally, we will use the free modelling tool Sculptris to refine some elements of the mesh. You don’t have to be an expert at modelling with Sculptris, as we will only do basic modelling with it.This tutorial is for beginners and intermediate users, although
pros will also find that the character creation tools are useful in their toolbox as well. iClone and Character Creator use .OB]J and .FBX files to work with any other 3D tool, so you can use Character Creator characters virtually anywhere. A video accompanies this process so you can get a better understanding of the individual steps and my workflow.



The Character Creator tool creates a 3D base mesh, which is a quickstart for character creation that gives you a fully rigged and facial animation-ready model you can customise with morphs and sculpting.Feel free to experiment and let your imagination run wild. Get started by testing some character morphs with the included base characters and
abundant customisation sliders. Character Creator offers unlimited possibilities to create the avatars you need. 01. Set up character creatorThere are plenty of base models to help you get started Character Creator provides a host of base models to get started creating your character. Choose the body’s style and size, then use the Morphing Tool or
Morph Sliders to shape the character by body part and facial feature. Before you begin the creation of the character, make sure you have set up CC correctly. After launching iClone Character Creator please press the Reset Button first. The default avatar should change its shape from female to male.Reference material will help to direct and inform
your character It’s important to find some references that illustrate how you want your character to end up looking. You can create a sketch on your own or search the internet for concept art - or other stuff. Art books, movies, games and so on are also great inspirational sources. Feel free to create your own reference library with a huge variety of
different styles and artists. I will use a concept art created by artist Helgeson Art, which illustrates the overall style I want to achieve.03. Getting startedWhen modelling from the head down, remember to constantly check the proportions Time to get things rolling. We will start modelling the head first. I usually start working on the head and adjust
the body afterwards, but it’s always good to keep an eye on the overall proportions. You will find all available morphs for the body and head section under the Modify>Actor panel. As we will create a male character, let’s change the skin texture to Base Male to have a better visual guide. Just open the Skin panel in the Content tab and apply the Base
Male texture.Shaping the character involves a great deal of trial and error Creating a character is a totally non-linear process that allows you to choose where you want to work and tweak as often as you like. I'm testing different slider values through trial and error. It’s important to have a look on your character from different angles, so move your
camera around and check your morphs from each side. If something doesn’t work, simply redo and try again, or combine another morph. Here you can see how I've created the base shape for my character.05. Morphing the base bodySliders can morph the body into the desired shape Experiment by trying out the different sliders to create your
desired shape. After you have created a handful of characters you will instinctively know which slider will work best for you. Morph select a body part in the viewport to left-click and edit with your mouse using click and drag to stretch and morph the character. You can see in my screenshot how I exaggerate the upper body compared to the lower
body - that’s how I want it.06. First test renderTest renders let you play with the shape and complexion Well, why not give your creation a try in iClone? I think it’s important to create some test renders from time to time, as it puts a new complexion on it and makes it easier to improve the shape. I really like to use Indigo, and iClone makes it easy and
fast to use. Just load the pre-made Indigo render scene from the iClone Scene Temp folder, send your character to iClone, create a nice pose and launch the Indigo Renderer.07. Refining the lookDon't be afraid of switching between tools to adjust the details The iClone render of the character is getting closer to what I want, but some things can be
improved - so back to CC. My character should not have a beard, so let’s get rid of it using the Appearance Editor. Additionally, I added some wrinkles to his forehead, cheeks and chin area to increase the visual detail. This can easily be done by adjusting the Roughness, Age and Strength Sliders in the Head Surface Normals section.08. Export the CC
characterExporting the CC character lets you make manual adjustments Some areas of the mesh need adjusting manually in an external modeller. There are two ways to export the mesh: directly from CC (File>Export to OBJ>Avatar, choose Body in the OBJ Exporter tab and export), or export via iClone through 3DXchange (send the character to
iClone and press Edit in the 3DXchange Modify tab). The character’s sent to 3DXchange. Find the RL. G6_BODY in the scene tree and export via the Export Mesh Button in the Modify/Replace Mesh tab.09. Edit the shape in SculptrisExporting to Sculptris allows the mesh to be refined Use the Import OBJ Button and find the exported character mesh
file on your computer. Create a New Scene and press No to the Paint Mode. The mesh should be imported. Check these options are disabled: Beautify/Relax mesh and Smooth Subdivide. I use two tools in Sculptris to refine my mesh: Grab and Smooth. Ensure the tool you use isn’t in Global mode as this only moves the mesh around in the scene. You
should see an orange circle when hovering over the character mesh.10. Finalise your characterFinal tweaks can be made even when the character is imported You can re-import your character mesh using the Replace Mesh Button in the Modify tab in 3DXchange. Just follow the instructions and your adjusted mesh will be imported. Now press Apply
To iClone to send the refined character back to iClone. The character looks almost perfect now. I just want to make some slight adjustments in CC again. Select your character and press Edit in Character Creator to send it back to CC.This article was originally published in 3D World magazine (opens in new tab) issue 211. Buy it here. (opens in new
tab) Thank you for reading 5 articles this month* Join now for unlimited accessEnjoy your first month for just £1 / $1 / €1 *Read 5 free articles per month without a subscription Join now for unlimited accessTry first month for just £1 / $1 / €1 3D gaming is soon set to move way beyond its current limited niche in the hardcore PC market, with console
manufacturers and game developers increasingly eager to provide us with compelling interactive content to play on the slew of new TVs set to hit the shelves later this spring.CES 2010 was, in many ways, a festival of 3D television tech, with pretty much every major TV manufacturer unveiling its latest 3D HD TV models - many of which will see a
commercial release later next month.The runaway successes of movies such as James Cameron's Avatar and Disney's UP have not only generated a much-welcome renewed interest in cinema-going, but they will also drive 3D TV sales when they arrive on Blu-ray later in 2010.Sky is also launching the world's first 3D television station in April which
will drive consumer adoption further. Just like that imaginary game of Tetris 3D we dreamed of the other night, the pieces are starting to fall into place.But what of 'proper' 3D gaming in our lounges? Are we still stuck in that annoying catch-22 stalemate position, where publishers won't invest the extra cash and developers won't go the extra mile
until a proven market (and that all-important return on investment) is in place?A brief history of 3D gamingThere have been numerous attempts to take console and handheld and PC gaming into the third dimension in the last twenty years. Most have been quickly (and rightly) dismissed by consumers as little more than cheap headache-inducing
gimmickry."We didn't worry so much about the past efforts, such as Nintendo's Virtual Boy or things like that," says Dale H Maunu, an analyst at 3D and display tech research firm Insight Media.VIRTUAL BOQOY: Failed to ignite a 3D gaming revolution in the '90s"3D gaming is really more recent, in terms of the ability to do Stereoscopic 3D ("S-3D")
gaming. The release of DirectX 8 ushered in the era of a standardized 3D API for MS Windows, which resulted in game developers and publishers creating more 3D assets in their games," adds Maunu."The move to DirectX 9 provided still more tools for game developers and is really the minimum requirement for S-3D gaming; many of the titles that
can be played in S-3D were developed for DirectX 9."Rewinding a couple of years back to 2008, there were already 3D monitors and systems available from the likes of iZ3D and Zalman for playing DirectX 9 games in S-3D. "The Zalman system used drivers from DDD, while iZ3D developed their own," says Maunu, adding, "the systems worked pretty
well, but the drivers generally needed to be hand-tweaked for each game since there was no standard or API for S-3D. Plus, the game developers were not directly involved in making their games work in S-3D so there was still quite a bit of variability in the S-3D experience from game-to-game."It was really the introduction of Nvidia's 3D Vision tech
early in 2009, along with its own S-3D API, that started to put some standards in place for games developers and games buyers."World of Warcraft introduced support for 3D Vision in early 2009, and Nvidia was able to convince many developers to support S-3D," says Maunu. And some cracking 3D-optimised PC titles soon followed including the likes
of Left 4 Dead 2, Resident Evil 5, Batman: Arkham Asylum and, most recently, the game spin-off of Avatar from Ubisoft.TechRadar spoke with Patrick Naud, Ubi's Executive Producer of Avatar, who told us that working on 3D "was a great experience for our team... any time we can get out there and be one of the first on a new technology like this, you
get a boost of creativity, and we had a lot of fun coming up with great ways to use the innovation to make a game that puts the player right into the environment and action."I personally see a lot of potential with combining 3-D with Natal," says the Avatar game producer. "These two technologies together will bring us even more immersive experience
to gameplay."The S-3D Gaming AllianceNeil Schneider is the Executive Director of the S-3D Gaming Alliance (S3DGA) - the non-profit and non-proprietary organisation that is generally considered to be the official voice and standards body for stereoscopic 3D gaming.Schneider disagrees with analysts such as Dale Maunu who claims that S-3D
gaming is a recent phenomenon in gaming, telling TechRadar that, "modern S-3D gaming has been around for a whopping twelve years!" (The S3DGA has put together its own potted history of S-3D gaming, and you can see Part 1 and Part 2 of that over on YouTube (Part 3 is currently in the works)).Schneider also points out that while Nvidia's own
3D marketing suggests 400 compatible video games, "this is for depth-only situations.... [and] once gamers attempt out of screen or pop-out settings, anomalies become much more prevalent, and this compatibility list is greatly reduced. Similar results can be expected from additional driver developers like DDD and iZ3D.""This is one of the reasons
why S3DGA was founded. We want that 400+ game support, and we want it industry-wide."Schneider also adds that he considers it inappropriate to give all credit Nvidia for developing S-3D standards. "This is not the case and is misinformed," says the S3DGA Director. "Its efforts are 100% proprietary, and is not standards based. Their drivers do not
work with the countless competing shutter glasses out there and Nvidia's first effort to pass an exact left and right image view to the display was done with Avatar: The Game, and this was handled through private arrangement."He adds that Ubisoft's Avatar: The Game "had equally native support for iZ3D, RealD's new format, Sensio's codec,
interlaced, and more" and that "Nvidia's left/right technique was just one of many viable implementations included in the game.Even with an in-game interface feature, 99% of Nvidia GeForce 3D Vision optimizations are profile based liked all the other driver developers. It is false to think otherwise. Avatar: The Game is the first and only true API
based game in the Nvidia camp, though this should grow soon enough.""This does not undermine the quality that NVIDIA puts out with their GeForce 3D Vision solution. I just think it's false to credit them with competitive innovations that don't yet exist."Several S-3D gaming standards are in the works by S3DGA. Neil Trevett, President of the
Khronos Group (OpenGL) and VP of NVIDIA Mobile Content, Habib Zargarpour, Senior Art Director for Electronic Arts, and Jon Peddie of Jon Peddie Research all serve on S3DGA's advisory board."If there was a single lesson from CES 2010, it's that NVIDIA is one of several viable players in the market. Additional players include Hyundai, Zalman, LG,
Acer, XpanD, and more to come. AMD and Bit Cauldron are just around the corner, too."Low entry barriersOf all the creative industries, it is games development that is uniquely positioned to immediately do the most interesting stuff with new 3D display and glasses tech. After all, games creators have been making their games in 3D for years, but
have to date only been limited by the fact that the game is viewed and played on a flat 2D monitor or television."It seems certain that with all sections of industry getting ready to rally behind 3D TV it is something game developers will have start putting in their sights," agrees Peter Walsh, Lead Programmer at Cohort Studios."Game developers are
uniquely poised to develop content to take advantage of 3D TV. Film makers, sports broadcasters, animation studios, and just about anyone else involved in TV need to make significant investments replacing their infrastructure of cameras, editing equipment, and so on to handle 3D data."Game developers on the other hand already have all that
information readily available. In fact we spend a great deal of time trying to make 3D worlds display well on a 2D screen. To make games work with 3D TV we already have the depth information available - we just need the means to convey that data to the new TVs." Page 2 Dell's own PC gaming brand, Alienware has also been working with Nvidia to
bring its new £450 AW 2310 120Hz gaming monitor to market this month, with Adam Griffin, Dell'sEMEA Product Operations Manager, telling TechRadar that he has already started playing through Half-Life 2 again, "but this time using the 3D Vision glasses and our new monitor, because it is a very different game...very immersive and very cool. It
now has that extra added edge to it, that makes you want to play all the way through it again."ALIENWARE DOES 3D: New £450 3D monitor is the latest for gamersGriffin clearly thinks we have reached a sweet spot for mass adoption of the new tech, noting that, "price points are much more accessible now, in addition to the increased understanding
of what 3D can bring to films and games that blockbuster movies like Avatar have created."But does he think that this means leading PC game developers such as Valve might go back and rework their PC classics to optimise them for 3D? And what more might developers do to push the experience forward?"It wouldn't surprise me, there are only a
few minor glitches that would need to be fixed to make the overall experience [of Half Life 2] better - things such as water effects and so on that look a bit weird right now in 3D," says Griffin."More generally, there is still a lot of work to be done, with things like first person shooter games, for example. You look at the cross-hairs on some fps games,
and it sits right in front of your eyes in 3D, which is really not a comfortable playing position for it to be. But there is definitely an opportunity for PC gaming companies to reinvent some of their key PC games for the 3D experience."The console market will no doubt begin to drive the masses towards 3D later in 2010 with the arrival of 3D PlayStation
3 blockbusters such as the aforementioned Gran Turismo 5, but for now it is purely PC gamers and early adopters - those that are buying Nvidia's kit and Alienware's new 3D monitors - that are leading the way."Absolutely," agrees Griffin, "which is why I am always proud to be part of the PC gaming industry. These are the people that blog
passionately about what they love and hate about new technologies, and they are the people that we rely on for that all-important feedback that helps us to develop the Alienware brand to make sure we are delivering what is required in the market."Both Dell and Alienware are currently monitoring the 3D laptops market, as we think there could well
soon be an opportunity for us to bring out our own 3D laptop solutions," says Griffin, with an obvious nod to the early attempts of manufacturers such as Asus to offer laptops with 120Hz 3D-capable screens.The future?Chris Chinnock, President of specialist display research and analysis firm Insight Media, told TechRadar recently that, "it is safe to
say that most games and all AAA games will be authored in 3D by 2020."This, he added, "does not mean they will all be played in 3D, but the capability will exist to do that. By then, I also expect decent performance from auto-stereoscopic displays, which means no glasses. Head/eye tracking will be widely used to improve the stereo effect."Speaking
to PC Zone recently, Sefton Hill, the director of Batman: Arkham Asylum said of the future of 3D gaming: "From our point of view 3D is just something to consider now, simply because the technology is here... there is now not much of a barrier in terms of getting the 3D to work well, the barrier now is really more about designing games that leverage
the 3D tech in the best ways."Bringing in elements of motion control will really help when properly used alongside 3D - so things like head-tracking, where you can move your head and look around to view objects in a proper 3D space."Likewise, Stephen Viljoen, the CEO of Slightly Mad Studios - who created a superb 3D experience for Need for
Speed Shift on PC, gives a glimpse of things to come:"I think what will happen next is that we will start designing around the potential of the 3D projection... when we start working with weather effects and you have totally convincing rain splashing out of the screen towards you and so on. That's when it will start to get really interesting."
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